SALESFORCE: HOW TO VISUALIZE, INTERACT WITH, AND ENHANCE REPORTS FROM SALESFORCE.COM
## TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUMMARY</td>
<td>3</td>
</tr>
<tr>
<td>Launching MicroStrategy Desktop</td>
<td>4</td>
</tr>
<tr>
<td>EXERCISE 1: IMPORT PRE-BUILT REPORTS FROM SALESFORCE INTO MICROSTRATEGY DESKTOP</td>
<td>6</td>
</tr>
<tr>
<td>Importing the Salesforce Report</td>
<td>6</td>
</tr>
<tr>
<td>EXERCISE 2: MERGE SALESFORCE DATA WITH EXCEL</td>
<td>14</td>
</tr>
<tr>
<td>Detailed Instructions: Importing Excel Data</td>
<td>14</td>
</tr>
<tr>
<td>EXERCISE 3: BUILD A DOSSIER WITH SALESFORCE DATA</td>
<td>17</td>
</tr>
<tr>
<td>Detailed Instructions: Creating the Table of Contents</td>
<td>17</td>
</tr>
<tr>
<td>Detailed Instructions: Creating the Overview Page</td>
<td>19</td>
</tr>
<tr>
<td>EXERCISE 4: PUBLISH YOUR DOSSIER TO A SERVER</td>
<td>42</td>
</tr>
<tr>
<td>EXERCISE 5: CERTIFY AND SHARE YOUR DOSSIER</td>
<td>47</td>
</tr>
<tr>
<td>EXERCISE 6: CONSUMING DOSSIERS FROM THE MICROSTRATEGY LIBRARY</td>
<td>49</td>
</tr>
<tr>
<td>APPENDIX A: EMBEDDING MICROSTRATEGY DOSSIERS INTO SALESFORCE AS A TAB</td>
<td>53</td>
</tr>
</tbody>
</table>
In this workshop, we will cover the following:
   a) Importing data from a Salesforce report
   b) Merging Salesforce data with Excel data
   c) Building a story-oriented dossier with data combined from Excel and Salesforce

**Note:** The data in this workshop is pulled from a live connection to Salesforce, so the numbers you see in the screenshots throughout this manual will be different from what you see on your screen.

The following will be provided to you in the Supporting Files folder:

- GlobalOpportunities.xlsx
- Items.xlsx
- Credentials_Salesforce.docx
- env-79172.mstrcc

The file **Credentials_Salesforce.docx** contains the credentials required to log into Salesforce, and the Excel files will act as datasets. The **env-79172.mstrcc** file will be used to upload your dossier to a server, so you can interact with it in the MicroStrategy Library.

**Note:** You need to have MicroStrategy Desktop installed on your machine to complete this workshop. If you haven’t already, download MicroStrategy Desktop from our website.
Launching MicroStrategy Desktop

1. Launch MicroStrategy Desktop on your machine
2. Click on the New Dossier button on the left-hand side of the interface

You will now enter the brand-new dossier authoring interface. Before we get started building a dossier, let’s briefly familiarize ourselves with the interface.

1. **Toolbar**: Provides controls to redo or undo an action, refresh the dossier, add dossier elements (including datasets, pages, chapters, visualizations, on-canvas filters, text, images, and links), change format, and share your dossier. This is also where you can take advantage of brand-new responsive design functionality and preview your dossier in mobile and presentation mode.

2. **Panel Control**: The icons on the far left-hand side of the interface are used to show or hide different panels.

3. **Contents Panel**: With dossiers, you can organize your information into a chapter and page structure, allowing you to tell a story about your data. The Contents
Panel is where you add chapters and pages to your dossier. Click on the editor icon in the Panel Control section to show or hide this panel.

4. **Dataset Panel**: The Dataset Panel shows the names and the elements of the datasets you have imported for your dossier. You can add additional datasets, delete datasets, and link two different datasets here. You can also add new metrics, attributes, links, etc. by right-clicking on the data elements in the panel. To show or hide this panel, click on the dataset icon in the Panel Control section.

5. **Editor, Filter, and Formatting panels**
   
a. **Editor Panel**: This is where you can drag and drop attributes and metrics to add data to your dossiers. Click on the editor icon in the Panel Control section to show or hide this panel.
   
b. **Filter Panel**: This is where you can add filters to your dossier at the chapter level, you can filter data based on the values of any attribute or metric to change your view to better understand your data. Simple checkboxes, sliders, calendars, and radio buttons make filters easy to use, and the impact of your selections is instantly visible. MicroStrategy also supports adding visualizations as a filter. Click on the filter icon in the Panel Control section to show or hide this panel.
   
c. **Format Panel**: With dossiers, you can apply formatting options to enhance a user’s ability to view and read the information in your visualizations. Formatting options vary depending on the type of visualization you are formatting. Click on the format icon in the Panel Control section to show or hide this panel.

6. **Visualization Gallery**: Use the **Visualization Gallery** to quickly select the visualization you want to use to display your data, or import a custom visualization with just a few clicks. Click on the visualization icon in the Panel Control section to show or hide this panel.
EXERCISE 1: IMPORT PRE-BUILT REPORTS FROM SALESFORCE INTO MICROSTRATEGY DESKTOP

In this exercise, you will first import a report from Salesforce called **GlobalOpportunities** into MicroStrategy Desktop. After importing the report, you will then use the data wrangling tool to prepare the dataset by performing the following functions:

- Delete empty and unwanted columns
- Modify entries in fields to create new categories

**Importing the Salesforce Report**

3. From the menu bar, click **Add Data** and select **New Data** to open the **Data Sources** interface.

4. For this workshop, you will import data from Salesforce, so select the **Salesforce Reports** option.

5. This will open a login page for Salesforce – enter the credentials provided to you in the supporting file **Credentials_Salesforce.docx** and click **Log In**.
**TIP:** Since all workshop attendees are sharing a single login, you may already be logged in. In that case, simply browse to the folders discussed below.

Once logged in, you will see your Salesforce folders displayed on the left. These folders contain your Salesforce reports, and can be expanded to let you access the reports inside.

6. Expand the folder **Unfiled Public Reports**, and drag the **GlobalOpportunities** report to the drop zone on the right.

**TIP:** In case you have any issues connecting to Salesforce.com, you can use the file `GlobalOpportunities.xlsx` that has been provided in the supporting files folder as a backup.

7. Click **Prepare Data** to preview and modify your data.
This will open a window that contains a preview of the data you are importing. From here, you can modify your data before it is imported. For example, you can choose to import your data in either a tabular or cross-tabbed layout, define data columns as attributes or metrics, insert column headers, and so on.

8. On the bottom half of the screen, expand the **Data preview** window to see the first 50 rows of data

Notice that the following columns contain empty fields: **Lead Source**, **Next Step**, and **Owner Role**. We will delete these columns along with the columns **Age**, **Created Date**, and **Opportunity Owner**.
9. Click **Wrangle** on the top-left corner of the screen

10. Select the **Lead Source** column to highlight it, then click the drop-down menu and select **Delete Column**

11. Repeat the previous step for the columns **Next Step, Age, Created Date, Opportunity Owner, and Owner Role**
**TIP:** For each action taken in the Data Wrangling window, a script is captured on the top right-hand corner of the interface. This can be used to revert actions, or can be saved and applied to other datasets that require similar data wrangling steps.

<table>
<thead>
<tr>
<th>Script</th>
<th>←</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0) Delete Column [Lead Source]</td>
<td>1) Delete Column [Next Step]</td>
<td>2) Delete Column [Age]</td>
<td>3) Delete Column [Created Date]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In the **Type** column, Salesforce allows us to categorize the type of each opportunity associated with an account into 6 different categories, including “none.” To make our analysis a little simpler, we will have only 2 types of opportunities; **New Customer** and **Existing Customer**. The **New Customer** category has already been correctly entered and we only need to convert all other categories in the column to the category **Existing Customer**.

12. To begin the conversion, click the drop-down menu on the column **Type** and select **Text Selector**.
13. In the resulting box at the bottom of the **Sample Data** section, hover alongside **(blank) (2)** and click on **Edit**

<table>
<thead>
<tr>
<th>Type</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Existing Customer - Replacement</td>
<td>6</td>
</tr>
<tr>
<td>Existing Customer - Upgrade</td>
<td>192</td>
</tr>
<tr>
<td>New Customer</td>
<td>99</td>
</tr>
<tr>
<td>(blank)</td>
<td>2</td>
</tr>
</tbody>
</table>

14. To change the blank values, type in **Existing Customer** then click the **Apply to All** icon to apply the selection to all blank rows in this column

15. Hover the cursor along **Existing Customer – Upgrade** and click **Edit**

16. Type in **Existing Customer**, or simply click on the newly created entry **Existing Customer** field, and then click the **Apply to All** icon to apply the selection

17. Repeat the previous two steps for the entry **Existing Customer – Replacement**.

Your text selector should now look like the image below:

18. Once you are done wrangling the data, click **Apply** at the bottom right-hand corner and then click **Finish** to exit the Preview window
Your Salesforce report data is now available in the Dataset Objects panel, and is ready to be used to create visualizations.

Currently, the Amount and Expected Revenue metrics are not formatted to reflect currency values. Let’s go ahead and change that.

19. Right-click Amount then Number Format to select Currency from the drop-down menu, remove the decimals by clicking twice and then click OK
20. Repeat the step for the Expected Revenue metric

21. Click the Save button on the toolbar

22. Save your dossier as GlobalOpportunities_YourName in the My Document folder on your computer - this file is now a shareable MicroStrategy file (.mstr extension)

TIP: When you save your dossier as a MicroStrategy (.mstr) file, the entire dossier, including visualizations, filters, images, and data cubes, is exported. You can share this file with other MicroStrategy users, who can import it into their own MicroStrategy environment to review, modify, or create new visualizations based on the data you share with them. Feel free to save your dossier at any point during the workshop using the Save button.

At this point you realize that the Salesforce report data on its own will not be sufficient to build a story of your business performance. You also need data on the overall performance of your business which is located in a different system. For the purposes of this workshop, we will assume that the data has already been provided to you in Excel format. The dataset we will be using for this is Items.xlsx, which you can find in the Supporting Files folder.
EXERCISE 2: MERGE SALESFORCE DATA WITH EXCEL

MicroStrategy’s multi-source feature allows a single MicroStrategy Dossier to access data from different sources, even if they are from entirely different database platforms. This is a huge advantage for business users who want to analyze data from Salesforce and other sources. In this exercise, we will cover how to merge Excel data with Salesforce.

Detailed Instructions: Importing Excel Data

23. From the menu bar, click Add Data and select New Data to open the Connect to Your Data interface

24. For this example, you will import data from an Excel file, so select the File from Disk option

25. Click Choose Files to browse your local machine and import a spreadsheet
26. Browse to the **Item.xlsx** file provided in the Supporting Files folder, select it, and then click **Open**.

27. After making sure that **Item.xlsx** has been selected and loaded, click on the **Prepare Data** button.

![Choose file dialog box](image)

After the data loads, you will be taken to the **Preview** window, which contains information about the attributes and metrics included in the **Item.xlsx** dataset.

28. In the bottom left half of the screen, click the up arrow next to **Items.xlsx** to expand the Data Preview window and make sure all the columns contain data.

29. After previewing the data and ensuring that no cells are missing data, click **Finish** to load the Excel dataset into your dashboard.

Your **Item.xlsx** dataset will appear just below the already imported Salesforce dataset.
Now that we have two different datasets in the dossier, we need to link them so we can use objects from both at the same time. To merge two datasets, they need to have at least one column in common. In this case, **Account Name** in the **GlobalOpportunities** dataset contain the same data as the **Customer** column in the **Item.xlsx** dataset. We must establish a link between the common attribute to merge the data into a single grid.

30. Right-click on the **Account Name** attribute from the **GlobalOpportunities** dataset and select **Link to Other Dataset**

31. Click the drop-down menu in the **Select an attribute** box
32. Select **Customer** and click **OK**

The two datasets are now linked; notice the icon beside the **Customer** attribute in the **Item.xlsx** dataset and **Account Name** attribute in the **GlobalOpportunities** dataset.

Having linked the two datasets, you can now begin building your interactive, story-oriented dossier. But first, save your progress.

**EXERCISE 3: BUILD A DOSSIER WITH SALESFORCE DATA**

Now that you have imported your data, you are ready to put together a compelling story for the Salesforce **GlobalOpportunities** dataset by building a dossier. Dossiers allow you to build a modern and interactive analytical book of your business. Each dossier consists of individual pages arranged in easy-to-navigate chapters. On each page, you can tell compelling stories about your data with powerful visualizations such as graphs and maps. To provide a guided experience for end users, dossiers include a **Table of Contents** that help you logically organize content.

**Detailed Instructions: Creating the Table of Contents**
33. Right-click on **Chapter 1** in the Table of Contents and rename it **Performance Summary**

34. Similarly, right-click on **Page 1** and rename it **Overview** – you want the first page of your dossier to show key performance indicators

![Image of renaming chapter]

35. Click the **Add Chapter** icon on the toolbar to insert a new chapter into your dossier - notice that adding a new chapter also adds a page in that chapter

![Image of adding chapter]

36. Right-click on the newly added chapter and rename it **Opportunity Analysis**

![Image of renaming page]

37. Click on the **Add Page** icon in the toolbar to add a new page under the **Opportunity Analysis** chapter

![Image of adding page]

38. Right-click on **Page 1** and rename it **Pipeline Details**
39. Similarly, right-click on **Page 2** and rename it **Top and Bottom Accounts**
40. Next, click the cover, choose the highlighted sample image, and then click **Save**
Your Table of Contents should now look like the image below:

Detailed Instructions: Creating the Overview Page

In the Performance Summary chapter on the Overview page, we want to display the Total Revenue, Profit, and Units Sold from the Items.xlsx dataset and show how these KPIs have been trending over time. The following steps will guide you through the process of creating the Overview page.

41. First, collapse the GlobalOpportunities dataset by clicking the icon next to the dataset label so that only objects from the Items.xlsx dataset are visible

Note: MicroStrategy allows users to easily create additional time-based attributes such as Year, Quarter, and Month based off of existing time attributes in a dataset.
42. Right-click the **Day** attribute, select **Create Time attributes**, and create derived attributes for Year, Quarter, and Month - as shown below:

![Image showing attribute creation](image)

You should now have the following new attributes:

![Image showing new attributes](image)

43. From the **Table of Contents**, click on the **Overview** page

44. Change the default grid visualization to a KPI visualization from the **Visualization Gallery** on the right

![Image showing visualization options](image)
45. Drag the **Revenue** metric from the *Items.xlsx* dataset into the corresponding **Metric** drop zone in the **Editor panel**

46. Click the **Format** tab to format the KPI visualization. Clear the check box **Show titlebar** to hide the visualization title bar

47. Click on the primary drop-down menu and change the selection to **KPI settings**

48. Under **KPI Name**, change the font color to **Light Blue**
49. From the toolbar, click the **Insert Visualization** icon twice to insert two additional visualizations.

50. Select Visualization 2 and repeat the steps above to create a KPI visualization displaying the **Profit** metric. For the font color, select **Gold**.

51. Select Visualization 3 and repeat the steps above to create a KPI visualization displaying the **Units Sold** metric - for the font color, select **Light Orange**.

52. Save your work.

53. From the toolbar, click the **Insert Visualization** icon to add a fourth visualization to the page and position it directly below all three KPI visualizations.

   To do this, you will have to click and hold the visualization title bar, then gently move it until you see a blue line at the bottom of all 3 visualizations.
54. From the **Dataset panel**, drag **Day (Quarter)** to the **Rows** drop zone and **Revenue**, **Profit**, and **Unit Sold** to the **Metrics** drop zone.

55. Change the default visualization to a combo chart by clicking the **Combo Chart** icon in the **Visualization Gallery**.
56. To merge the y-axes, drag the **Metrics Names** object from the **Vertical** drop zone to the **Break By** drop zone.

57. To distinguish the metrics by color, drag the **Metrics Names** object from the **Break By** drop zone into the **Color By** drop zone.

58. To adjust the colors of the combo chart, click the **Format** tab, and then select **Shapes and Data Labels** in the primary drop-down menu.
59. Under **Shape Formatting**, click the drop-down menu and select **Revenue**

60. Change the **Shape Color** to **Light Blue** and make sure the **Fill Opacity** is **70%**

61. Repeat the previous steps for **Profit** and **Unit Sold**, using **Gold** for **Profit** and **Light Orange** for **Unit Sold**.

62. Your visualization should resemble the image below.
63. In the Format tab, select **Title and Container** from the primary drop-down menu and clear the checkbox **Show titlebar** to remove the visualization title bar.

64. Right-click on a grid line inside the combo chart and select **Hide**.

You can also minimize the legend by clicking the arrow icon.
65. Click on the **Image** icon in the toolbar to insert an image to serve as a logo for this page.

66. In the text box, copy and paste the URL below (also provided in the Supporting Files) and click **OK**:

   https://www.microstrategy.com/getmedia/2e3b0b9b-aeef-46af-a08b-f7ea2bd39383/world2018-logo

   > *Your Overview page should now look like the image below:*
Detailed Instructions: Creating the Pipeline Details Page

The following instructions relate to building the **Pipeline Details** page. For this page, we will create two visualizations to highlight the different stages the opportunities are in and the revenues associated with each stage. We will use a bar chart for this. We will then add a heat map visualization to show the accounts that make up the opportunities in the different stages. Finally, we will connect the two visualizations so that clicking a bar on the bar chart automatically filters the heat map.

67. From the Table of Contents, select the **Pipeline Details** page, and then expand the **GlobalOpportunities** dataset to show all of its attributes and metrics.

68. Click the **Bar Chart** visualization from the **Visualization Gallery**.

![Bar Chart Visualization](image)

69. From the **Dataset Objects** panel, drag the **Stage** attribute to the **Vertical** drop zone, **Amount** metric to the **Horizontal** drop zone and **Type** attribute to the **Color By** and **Break By** drop zones.

Your bar chart should now look like the image below:
70. Click **Format**, in the main application menu, and change the palette from **Classic 1** to **Sunset**

71. Click the **Format** panel and then click the drop-down menu to select **Shapes and Data Labels**
72. Under **Data Labels**, click **Values** to display values for each opportunity stage.

73. From the drop-down menu, select **Axis Lines and Labels**.

74. Under **Axis Titles**, clear the box **Show axis titles**.

75. Under **Grid Lines**, change the drop-down menu selection from **Automatic** to **Hide**.

Your settings should now look like the following:

This completes the visualizations for the different stages and their associated revenues. We will now add a visualization to show the accounts that are in each of these stages and then use this visualization as a filter.
76. Click the **Insert Visualization** icon to create a new visualization and position it below Visualization 1

77. Change the newly created visualization from a grid to a **Heat Map** visualization - notice that the editor panel now includes a **Grouping** drop zone.

78. Drag the **Account Name** attribute into the **Grouping** drop zone, and the **Amount** metric into the **Size By** and **Color By** drop zones respectively.
While the red-green color range provides a good contrast, to match the bar graph visualization above, we will change the color range of the heap map to orange.

79. Click on the **Format tab**, select **Data Exploration** from the primary drop-down menu, and then click the link to **Select Color Ranges** as shown below.

80. Change the color range from **Red-Green** to **Orange** and keep the **Based on** selection as **Lowest %** so that higher percentage rankings are orange and lower percentage rankings are red – you may need to click **Reversed** to switch the order.

81. Click **OK** to apply the color range.
Your heat map should now look like the one below:

82. To make Visualization 1 act as a filter of Visualization 2, click the ellipses icon on the top right-hand corner of Visualization 1 and then click **Select Targets**

83. Click on **Visualization 2** to set it as the target and then click **Apply** at the top-right corner so that the configuration takes effect.
84. Test the filtering by clicking on any bar in Visualization 1 and noting the changes in Visualization 2

85. Click anywhere on Visualization 1 other than a bar to reset the filter and see all the accounts

86. Rename the visualizations as follows: Visualization 1 as **Overall Pipeline Value**, and Visualization 2 as **Account Pipeline**

87. Save your work

Your completed **Pipeline Details** page should now look like the image below:
Now that you have completed the Pipeline Details page, you can proceed to visualize the top and bottom performing accounts in your pipeline. We will do this by completing the Top and Bottom Accounts page within the Opportunity Analysis chapter.

Detailed Instructions: Creating the Top and Bottom Accounts Page

88. To get started, click the Top and Bottom Accounts page in the Table of Contents

89. From the Visualization Gallery, select the Bar Chart icon to change the default grid to a bar chart

90. From the Dataset panel, drag the Account Name attribute to the Vertical drop zone, Amount metric to the Horizontal drop zone, and Type attribute to the Color By and Break By drop zones
Your **Editor panel** should look like the image below, with the corresponding bar chart to the right:

Right now, this visualization is showing data for all the accounts, hence the scroll bar to the right. Next, we will filter the visualization so that it only displays the top 10 accounts by revenue.

91. Hover over the top right-hand corner of the visualization, click the ellipses icon and select **Edit Filter**

92. In the **Advanced Filter Editor-Visualization 1** box, click **Add New Qualification**

93. Click the drop-down menu under **Based On** and scroll down to select **Amount**
94. Change the **Operator** to **by Rank** and select **Highest**

95. Type 10 in the box for **Value** and click **OK** to close the window

96. Click **Save** to close the **Advanced Filter Editor**

97. Right-click the **Amount** metric label on the x-axis below the visualization and select **Sort Descending**.

Your visualization should now look like the following:
98. To enhance the look of the visualization, click on the **Format panel** and select **Axis Lines and Labels** in the drop-down menu - make the changes as shown in the image bellow:

99. Select **Shapes and Data Labels** from the primary drop-down menu, and then click **Values** under **Data Labels**
100. Rename the visualization **Top 10 Accounts** and **Save** your work

Your visualization should match the image below:

Now that we can see our top 10 accounts, we will add another visualization to highlight our bottom 10 accounts. To do this, we will duplicate the current Top 10 Accounts visualization and change the filter qualification.
101. Hover over the top-right corner of the visualization, click the ellipses icon and select **Duplicate**

102. On the newly created **Top 10 Accounts copy** visualization, hover over the top-right corner, click the ellipses icon and then click **Edit Filter**

103. The **Advanced Filter Editor** already contains a filter qualification. Modify it to Lowest 10 by clicking on **Rank of ‘Amount’ Highest 10**

104. Select **Lowest** and then click **OK**
105. Click **Save** to close the **Advanced Filter Editor**

106. Rename the new visualization **Bottom 10 Accounts**

Your page should look like the following:

107. **Save** your work
Congratulations! You have now completed the major part of building your dossier. You have blended data from Salesforce.com with sales performance data in Excel in a beautiful, interactive dossier using MicroStrategy Desktop. You can now interact with your new dossier in presentation mode by clicking the Presentation Mode icon in the top right-hand corner of the interface.

EXERCISE 4: PUBLISH YOUR DOSSIER TO A SERVER

If you want to share this dossier with colleagues and want them to be confident that the content is accurate and has your seal of approval, you need to certify your dossier. You need to first publish your dossier to a MicroStrategy enterprise environment. The following exercises will guide you through this process.

108. From the File menu, select **Save As**.

![Save As](image1.png)

109. Name your dossier **GlobalOpportunities_<your name>**, then click **Browse Environments** to locate the workshop environment.

![Browse Environments](image2.png)

110. In the ensuing message, click on **Connect Environment**.

![Connect Environment](image3.png)
111. In the Connect to Environment dialog box, click **Select A File**

112. Navigate to where you saved the .mstrc file provided for this workshop

113. Select the file and click **Open**.

The following image may differ from yours depending on the .mstrc file provided:

114. You will then be presented with details of the environment and available authentication modes. Accept the default Standard authentication mode to allow you to use a user name and password

115. Click **Continue**
116. In the subsequent login page, enter the username and password provided in the Supporting Files and click **Connect**

You will be presented with all the projects available in your environment to which you can associate your Dossier.

117. Select **MicroStrategy Tutorial** and click **OK** to continue.
118. In the subsequent dialog box, double-click **MicroStrategy Tutorial** and all the folders contained therein will be shown to the left and also on the window.

119. Navigate to **Public Objects>Reports>World2018 Dossiers**. You may have to click **Show All (8)** to see and double-click the **World2018 Dossiers** folder.

120. Click **Save**.

121. You have successfully published a copy of your dossier to the MicroStrategy server. To view it and interact with it in MicroStrategy Web, first login to MicroStrategy Web using the URL and credentials provided in the Supporting
Files. Then navigate to the Shared Reports folder and locate the **World2018 Dossiers** folder as indicated in the navigation bar of the image below.

122. Open your **GlobalOpportunities_YourName** dossier by clicking on it.

This takes you to the web version of dossier authoring, which is similar to the Desktop version, only with added functionalities that will be covered in the next set of exercises.
Certified dossiers help to maintain a single version of truth, while providing flexibility for authoring content with multiple users.

Certify your dossier and add it to the Library.

1. **Save** and close your dossier by going to File-> Close.

2. In the folder World2018 Dossiers, right-click on your dossier and select **Properties**.

3. Check the box for **Certified** and click **OK**. Your dossier is now certified.
126. Re-open the dossier by clicking it.

127. Click **Share** on the menu bar, and click **Get a link to MicroStrategy Library**.

128. Click **Launch** to go to **MicroStrategy Library**, where you can test the experience of interacting with your dossier in a collaborative environment.

129. Log in using the MicroStrategy Web credentials provided, allow notifications in your web browser (if needed), and click **Add to Library** to add this dossier to your **Library**.

130. Click on the **Library** icon to go to your **Library** page.

You will now see your dossier in Library with a time frame when it was uploaded.
EXERCISE 6: CONSUMING DOSSIERS FROM THE MICROSTRATEGY LIBRARY

Now that you have explored the Library a little bit, it’s time to consume your dossier in the Library. In addition to further analyzing your data, consuming your content from the Library allows you to optimally navigate your dossier and collaborate in real-time with your peers.

When consuming dossiers in the MicroStrategy Library, navigation is no longer limited to the traditional Sheet and Panel format. Rather, it’s organized into a Table of Contents.

The Table of Contents provides a simplistic, intuitive navigation method for you to interact with your dossiers like a book.

131. Open your dossier in your library by double-clicking it.

132. Open the Table of Contents to view the content of your dossier.

133. Navigate to different chapters and pages from your Table of Contents.
When consuming content through the MicroStrategy Library, you can now collaborate with other users in real time via the collaboration panel. With MicroStrategy 10.10, you can tag users at the page level and filter manipulations at the chapter level to directly pass context to other users. For the sake of this exercise, assume that the MSTR user created this dossier.

134. Open the comment panel by clicking the icon to begin a conversation with the dossier author.

135. Type a comment in the comment box and then type @MSTR to tag the dossier author in your comment.

136. To ensure that the MSTR user is viewing your dossier in the same view, include your filter state in the comment by clicking the icon and posting your comment.
TIP: Once the filter has been tagged in the collaboration panel, any user viewing this dossier can click on the filter icon in the comment and apply the same filter to the dossier.

If there is a particular user you want to communicate with about a specific aspect of the dossier right away, rather than writing a note in the collaboration panel, you want to ensure that the user can access the dossier in their Library so that you can discuss it with them when you meet in person. In this case, we assume that you want to meet and discuss this Dossier with Barbara Aoter, one of your Account Executives.

137. Click on the share icon  and select Invite Users from the available options.

138. Start typing Barbara to find Barbara Aoter, check the name box, and click Invite.
At this point the invited user will get a notification email that he/she has been invited to view the dossier. Consumers can also easily download a dossier as a .MSTR file for offline use

139. From the menu select Download MSTR file.

You have now completed the workshop. Congratulations!!
APPENDIX A: EMBEDDING MICROSTRATEGY DOSSIERS INTO SALESFORCE AS A TAB

These steps illustrate the prerequisites and are not intended to be performed during the workshop. The screenshots illustrated here were captured in a different version of Salesforce.

1. Login to Salesforce and expand the Develop Option in the Build Menu and click on Visualforce Pages.

2. Click New.
The contents of the page is
<apex:page sidebar="false">
  <div>
  </div>
  <style>
    #theFrame {
      height: 768px;
      width: 1024px;
    }
  </style>
</apex:page>

3. Click **Save**. Now Under App Setup, choose **Create**, and then click on **Tabs**.

4. Choose the page that was just created and fill in other appropriate details (name, label, icon). Then click **Next**.
Choose where the new tab should be ‘on’ and click Next.

5. Choose the apps where the tab should be shown and click Save. You should now see the new tab in the menu

Section 2: Enable Mobile (Salesforce 1) Tab

Under the Administration Setup menu, choose Mobile Administration and then click ‘Salesforce1 Navigation’.
6. On the Mobile Navigation screen, choose **MSTR Embedded** (that we created earlier) and move it to the ‘Selected’ section.

7. Click **Save**. You should now be able to open the Salesforce1 mobile app and see the **MicroStrategy Tab** (MSTR Embedded) as one of the options in the menu on the left.

8. When you click on the tab, it will take you to the MicroStrategy environment.